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Week 1 
At the end of week 1 Laboratory practical, students should be able to: 

(1) Load Ms Word and study the various components of Ms Word screen  

(2) Load Ms Excel and study the various components of Ms Excel screen  

(3) Load Accounting Packages such as Peach tree or DacEasy Accounting and study the  

     various screen components 

(4) Load Ms Power point and study the various screen components 

(5) Load any of the Medical Software packages and study the various screen components 

(1a) Loading Ms Word Application Package 

To load Ms Word for Windows, follow the steps given below: 

(i) Click on Start Button 

(ii) Point to All Programs 

(iii) Click on Ms Word. 

See illustration below: 

 

 

 

 



 

(1b) Getting to know the following components of Ms Word screen: 

(i) The Title bar 

(ii) The Menu bar 

(iii) Standard Tool bar 

(iv) Formatting Tool bar 

(v) The Ruler bar 

(vi) The Ms Word editing screen 

(vii) Horizontal and vertical scroll bars 

(viii) Status bar 

(ix) Task bar 

(x) Start button 

Exercise: 

Guide the Students to identify and label correctly the components of Ms Word screen represented 

below: 

 

 

 

 



(2a) Loading Ms Excel Spreadsheet Packages 

To load Ms Excel for Windows, follow the steps below: 

(i) Click on Start Button 

(ii) Point to All Programs 

(iii) Click on Ms Excel. 

See illustration below: 

 

 

 

 

 

 

 

 

 

 

 

(2b) Getting to know the following components of Ms Excel screen: 

(i) The Title bar 

(ii) The Menu bar 

(iii) Standard Tool bar 

(iv) Formatting Tool bar 

(v) The Formula bar 

 



(vi) The Ms Excel editing screen/Worksheet Editing area 

(vii) Horizontal and vertical scroll bars 

(viii) Status bar 

(ix) Task bar 

(x) Start button 

Exercise: 

Guide the Students to identify and label correctly the components of Ms Excel screen represented 

below: 

 

 

 

 

 

 

 

 

(3) 

Loading Accounting Software Package: 

(3a) Loading Accounting Software Package 

In this case the Accounting Software Package could be Peachtree or DacEasy Accounting: 

To load DacEasy Accounting Software package for Windows, follow the steps below: 

 



(i) Click on Start button 

(ii) Point to all Programs 

(iii) Select DacEasy 

(iv) Point to Modules 

(v) Select Accounting 

See illustration below 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

(3b) Exercise: 

Guide the Students to identify and label correctly the components of DacEasy Accounting Software 

Package screen represented below or any other Accounting Software Package Screen 

 

 

 

 

 

 

 

 

 

 

(4a) Loading Ms Power point for Windows 

To load Ms Power point for Windows, follow the steps below: 

(i) Click on Start Button 

(ii) Point to All Programs 

 



(iii) Click on Ms Power point. 

See illustration below: 

 

 

 

 

 

 

 

 

 

 

 

(4b) Getting to know the following components of Ms Power point Screen 

 

(i) The Title bar 

(ii) The Menu bar 

(iii) Standard Tool bar 

(iv) Formatting Tool bar 

(v) Outline Pane 

(vi) Slide pane 

(vii) Note pane 

(viii) Status bar 

(ix) Task bar 

(x) Start button 

 



 

Ms Power Point Opening Sreen 

 

 

 

 

 

 

 

 

Ms 

Power Point Editing Screen 

 

 

 

 

 

 

 

 

 

 



(5a) Loading Medical Software Package (e.g. Home Doctor) 

To load Medical Software Package such as The family home Doctor for Windows, follow the steps below: 

(i) Click on Start button 

(ii) Point to All Program 

(iii) Select Family Doctor-4
th

 Edition or any other Edition installed on your System 

(iv) Select the Family Doctor 

See illustration below: 

 

 

 

 

 

 

 

 

 

(5b) Exercise: 

Guide the Students to study carefully and in detail the Family home Doctor Software Package screens 

represented below: 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Week 2  
At the end of week 1 Laboratory practical, students should be able to: 

(1) Load Ms Word and study the various components of Ms Word screen  

(2) Load Ms Excel and study the various components of Ms Excel screen  

(3) Load Accounting Packages such as Peach tree or DacEasy Accounting and study the  

     various screen components 

(4) Load Ms Power point and study the various screen components 

(5) Load any of the Medical Software packages and study the various screen components 

(1a) Loading Ms Word Application Package 

To load Ms Word for Windows, follow the steps given below: 

(i) Click on Start Button 

(ii) Point to All Programs 

(iii) Click on Ms Word. 

See illustration below: 

 

 

 

 

 



(1b) Getting to know the following components of Ms Word screen: 

(i) The Title bar 

(ii) The Menu bar 

(iii) Standard Tool bar 

(iv) Formatting Tool bar 

(v) The Ruler bar 

(vi) The Ms Word editing screen 

(vii) Horizontal and vertical scroll bars 

(viii) Status bar 

(ix) Task bar 

(x) Start button 

Exercise: 

Guide the Students to identify and label correctly the components of Ms Word screen represented 

below: 

 

 

 

 

 



(2a) Loading Ms Excel Spreadsheet Packages 

To load Ms Excel for Windows, follow the steps below: 

(i) Click on Start Button 

(ii) Point to All Programs 

(iii) Click on Ms Excel. 

See illustration below: 

 

 

 

 

 

 

 

 

 

 

 

 

(2b) Getting to know the following components of Ms Excel screen: 

 

(i) The Title bar 

(ii) The Menu bar 

(iii) Standard Tool bar 

 



(iv) Formatting Tool bar 

(v) The Formula bar 

(vi) The Ms Excel editing screen/Worksheet Editing area 

(vii) Horizontal and vertical scroll bars 

(viii) Status bar 

(ix) Task bar 

(x) Start button 

 

Exercise: 

Guide the Students to identify and label correctly the components of Ms Excel screen represented 

below: 

 

 

 

 

 

 

 

 

(3) 

Loading Accounting Software Package: 

(3a) Loading Accounting Software Package 

 



In this case the Accounting Software Package could be Peachtree or DacEasy Accounting: 

To load DacEasy Accounting Software package for Windows, follow the steps below: 

(i) Click on Start button 

(ii) Point to all Programs 

(iii) Select DacEasy 

(iv) Point to Modules 

(v) Select Accounting 

See illustration below 

 

 

 

 

 

 

 

 

 

 

 



3b) Exercise: 

Guide the Students to identify and label correctly the components of DacEasy Accounting Software 

Package screen represented below or any other Accounting Software Package Screen 

 

 

 

 

 

 

 

(4a) 

Loading 

Ms 

Power 

point for Windows 

To load Ms Power point for Windows, follow the steps below: 

(i) Click on Start Button 

(ii) Point to All Programs 

(iii) Click on Ms Power point. 

 



See illustration below: 

 

 

 

 

 

 

 

 

 

 

(4b) Getting to know the following components of Ms Power point Screen 

(i) The Title bar 

(ii) The Menu bar 

(iii) Standard Tool bar 

(iv) Formatting Tool bar 

(v) Outline Pane 

(vi) Slide pane 

(vii) Note pane 

(viii) Status bar 

(ix) Task bar 

(x) Start button 

 

Ms Power Point Opening Sreen 

 

 



 

 

 

 

 

 

 

Ms 

Power Point Editing Screen 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



(5a) Loading Medical Software Package (e.g. Home Doctor) 

To load Medical Software Package such as The family home Doctor for Windows, follow the steps below: 

(i) Click on Start button 

(ii) Point to All Program 

(iii) Select Family Doctor-4
th

 Edition or any other Edition installed on your System 

(iv) Select the Family Doctor 

See illustration below: 

 

 

 

 

 

 

 

 

 

(5b) Exercise: 

Guide the Students to study carefully and in detail the Family home Doctor Software Package screens 

represented below: 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Week 3 
At the end of week 1 Laboratory practical, students should be able to: 

(1) Load Ms Word (or any other Word Processing Package)  

(2) Study and know the components of Ms Word screen  

(3) Type and Save a document for the first time in Ms Word 

(4) Change the Font name, font color and font size in Ms Word document 

(5) Bold a text, underline a text and italicize a text in Ms Word 

(6) Close and Open Ms Word document 

(1) Loading ms word application package 

To load Ms Word Document, follow the steps given below: 

(i) Click on Start Button 

(ii) Point to All Programs 

(iii) Click on Ms Word. 

See illustration below: 

 

 

 

 



(2) Getting to know the following components of Ms Word screen: 

(i) The Title bar 

(ii) The Menu bar 

(iii) Standard Tool bar 

(iv) Formatting Tool bar 

(v) The Ruler bar 

(vi) The Ms Word editing screen 

(vii) Horizontal and vertical scroll bars 

(viii) Status bar 

(ix) Task bar 

(x) Start button 

 

Exercise: 

Guide the Students identify and label correctly the components of Ms Word screen represented below: 

 

 

 

  

 

 

 

 

 

 

 

 



(3) Typing and saving a document for the first time 

To type and save a document in Ms Word, follow the Steps below: 

(i) Load Ms Word (i.e. Start → All Programs → Ms Word) 

(ii) On the Ms Word Editing Screen, Start typing your text with the aid of a keyboard already connected 

to your system 

(iii) Click on File menu and choose Save as 

(iv) Type your document file name in the file name box 

(v) Click on Save 

See illustration below: 

 

 

 

 

 

 

 

 

 

 

 



4) Changing a font name, font color and font size in ms word 

To Change a Font name, follow the steps below: 

(i) Type your Text and highlight or select the text by dragging the mouse across the text 

(ii) Click on the Font Name drop down list on the formatting tool bar 

(iii) Select or click on a font name of your choice 

See illustration below: 

 

 

 

 

 

 

 

 

 

 

 

Changing a font color 

To Change a Font Color, follow the steps below: 

(i) Type your Text and highlight or select the text by dragging the mouse across the text 

(ii) Click on the Font color drop down list on the formatting tool bar  

 



(iii) Select or click on a font color of your choice 

See the illustration below 

  

 

Changing a font size 

To Change a Font size, follow the steps below: 

(i) Type your Text and highlight or select the text by dragging the mouse across the text 

(ii) Click on the Font size drop down list on the formatting tool bar 

(iii) Select or click on a font size of your choice 

See illustration below 

 

 

 

 

 



 

 

 

 

 

 

 

(5) Bold facing, italicizing and underlining a text 

To bold face, italicize and underline a text, follow the steps below: 

(i) Type your Text and highlight or select the text by dragging the mouse across the text 

(ii) Click on the Bold icon  (i.e. B ) on the formatting tool bar to bold face the text 

(iii) Click on the Italic icon (i.e. I) on the formatting tool bar to italicize the text 

(iv) Click on the Underline icon on (i.e. U) the formatting tool bar to underline the text 

(5) Closing and opening Ms Word document 

To Close and Open Ms Word document, follow the steps below: 

(i) Ensure you have created and saved the document you want to close and open 

(ii) Click on File menu and choose close  

(iii) Click on File menu and choose Open 

(iv) Select the folder in the look in box where your document is stored 

(v) Highlight your document name and click on open 

 

 



Week 4 
 

At the end of week 2 Laboratory practical, students should be able to: 

(1) Search for a word and then replace that word with another word in Ms word 

(2) Add headers and footers to Ms Word document 

(3) Add page numbers to Ms Word document 

(4) Add page borders to Ms Word document 

(5) Import graphics from the clip Art gallery into Ms Word document 

(6) Format Ms Word document into Newspaper Style column and create an initial drop  

      cap effect 

(1) Searching and replacing a word in ms word 

To Search and Replace a word in Ms Word, follow the steps below: 

(i) Display an existing word document or create one 

(ii) Click on Edit Menu and Choose Find 

(iii) In the Find What Box, Enter the Word you want to find in the document 

(iv) Click on replace button and enter the word to be replaced with in the Replace with  

      Box 

(v) Click on Replace to replace the word or click on Replace all to replace all such  

      occurrences. 



See illustration below: 

 

 

 

 

 

 

 

 

 

 

(2) Adding headers and footers 

To add headers and Footers to Ms Word Document, follow these steps: 

(i) Click on View Menu and select Header and Footer 

(ii) Type your Header in the Header box 

(iii) Click on Switch between Header and Footer button 

(iv) Type your Footer in the Footer box 

(v) Click on Close button to return to document page 

 

 

 

 

 



See illustration below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

(3) Adding page numbers to ms word document 

To Add Page Numbers to Ms Word Documents, follow the Steps below: 

(i) Click on Insert menu and choose page number 

(ii) Choose the page number Position and the Alignment  

(iii) Click on Format tab and Select the Number Format 

(iv) In the Page Numbering Start at dialog box, select your choice and Click Ok 

(v) Click OK again to get it done 

 



 

 

See illustration below: 

 

 

 

 

 

 

 

 

 

 

 

 

(4) Adding page borders to ms word document 

To add page border to Ms Word document, follow these steps: 

(i) Display the  Document page you want to add page border 

(ii) Click on Format Menu and choose borders and shading 

(iii) Click on page border tab, select your setting 

(iv) Click on Apply To box, select First page only 

(v) Click OK to get it done 

 



See illustration below: 

 

 

 

(5) Importing graphics from the clip art gallery 

To import graphic from the Clip art gallery into your document, follow these steps 

(i) Position the text cursor where you want your graphics to be displayed 

(ii) Click on Insert Menu and point to picture 

(iii) Click on Clip Art and Select a Category 

(iv) Click on Insert to display the graphics in your document 

See illustration below: 



 

 

(6) Creating newspaper-style columns 

To create Newspaper Style columns in Ms Word document, follow the steps below: 

(i) Click on Format Menu and Choose Columns 

(ii) Choose your option in the Columns Preset dialog box 

(iii) Click to select Line between box 

(iv) Click on Apply to Box and Select this Point Forward 

(v) Click on OK button then Start typing your text and observe as Ms Word format your document into 

Multiple columns 

 

 

 



 

Illustration of Newspaper Style Column with Drop Cap effect 

 

 

 



 

Week 5 
At the end of week 5 Laboratory practical, students should be able to: 

 (i) Format Ms Word document into double line spacing 

(ii) Create, modify and Format Tables in Ms Word 

(iii) Draw flowchart in Ms Word using AutoShapes 

(iv) Type basic Statistical and Mathematical equations in Ms Word 

(v) Protect Ms Word document from unauthorized users. 

 

(1) Formatting Ms Word document into double line spacing 

To format Ms Word document into double line spacing, follow the steps below: 

(i) Display the document page that you want to format into double line spacing 

(ii) Click on format menu and select paragraph 

(iii) Click on the line spacing drop down list and select double 

(iv) Click OK and start typing your document 

Or alternatively, 

(i) Display the document page that you want to format into double line spacing 

(ii) Select or highlight the document 

(iii) Click on format menu and select paragraph 



(iii) Click on the line spacing drop down list and select double 

(iv) Click OK to get it done 

See illustration below: 

 

 

 

(2) Creating, modifying and formatting tables in Ms Word 

To create, modify and format tables in Ms Word, follow the steps below: 

(i) Position the insertion point where you want your table to be 

(ii) Click on table menu and select insert table 

(iii) Select the number of columns and number of rows for your table  



(iv) Click OK 

 

 

 

See illustration below: 

 

 

To modify the table, first decide whether you want to modify by insertion or by deleting. 

To Modify by Inserting columns or rows, follow the steps below: 

(i) Highlight the table 



(ii) Click on table menu 

(iii) Select insert 

(iv) Choose either columns/rows to the left or columns/rows to the right 

To Modify by Deleting columns or rows, follow the steps below: 

(i) Highlight the table 

(ii) Click on table menu 

(iii) Click on Delete and select columns or rows 

(iv) Choose either columns/rows to the left or columns/rows to the right 

(3) Using AutoShapes to draw flowchart in Ms Word 

 

 

 

 

 

 

 

 

 

 



 

You can use AutoShapes to draw flowchart such as the one shown above. 

To do this, follow the steps below:  

(i) Display the document page where you want the flowchart to be 

(ii) Click on the AutoShapes drop down list on the status bar 

(iii) Select a flowchart symbol of your of your choice by clicking on it 

(iv) Use a click-drag operation to create the shape on the screen 

(v) Select other flowchart symbols to get the flowchart the way you want 

(vi) Click on Draw drop down list on the status bar and select group 

See illustrations below: 

 

 

 

 

 

 

 

 



 

(4) Typing basic Statistical and Mathematical equations in Ms Word: 

To type a Statistical or Mathematical equations, follow the steps below: 

(i) Position the cursor or insertion point where you want the equation to be 

(ii) Click on Insert Menu  

(iii) Choose object 

(iv) Click on Microsoft Equation 3.0 

(v) Click on Ok and  

(vi) Select the equation mode that corresponds to your equation 

(vii) Begin to type your equation 

See illustration below. 

  

 

 

 

 

 

 



 

(5) Protecting Ms Word document from unauthorized access 

(i) Display the document you want to protect 

(ii) Click on File Menu 

(iii) Click on Save As 

(iv) Click on Tools drop down list 

(v) Select general option 

(vi) Enter your password in the password to Open and password to modify dialogue boxes and click Ok 

(vii) Reenter your password in the Reenter password to open dialogue box and click Ok 

(viii) Click on Save to get it done 

See illustration below: 

 



 

 

 

 



 

Week 6 
 

At the end of week 6 Laboratory practical, students should be able to: 

(i) Know how to move from one cell to another in Ms Excel 

(ii) Enter Values and Labels into a worksheet 

(iii) Clear contents, formats or comments from cells 

(iv) Insert a new Worksheet in a Workbook or delete one from a Workbook 

(v) Print Preview a document in Ms Excel 

(1) Moving from one cell to another in Ms Excel: 

To move from one cell to another in Ms Excel, perform the following operations:  

(i) To move from the current cell location to the closest cell press right, left, up or down arrow 

key depending on your choice of direction of movement 

(ii) To jump to the last row in the Worksheet press Ctrl + ↓ (i.e. Ctrl and down arrow key) 

(iii) To jump to the last column in the Worksheet press Ctrl + → (i.e. Ctrl and right arrow  

       key) 

(2) Entering values and labels into a Worksheet: 

To enter values (numeric data items) or labels (alphabetic data items) into a worksheet, perform 

the following operations: 

(i) Select the cell where you want to enter data 



 

(ii) Type the data 

(iii) Press enter 

(3) Clearing contents, formats or comments from cells: 

  To clear contents, formats, or comments from cells, follow the steps below: 

  (i) Select the cells, rows, or columns you want to clear. 

  (ii) Click on the Edit menu and point to Clear 

  (iii) Click on All, Contents, Formats, or Comments.  

See illustration below: 
 

 

 
 
 
(4) 

Inserting a Worksheet into a Workbook or deleting one: 
 
To insert a Worksheet into a Workbook, follow the steps below: 



(i) Click on Insert menu 

(ii) Choose Worksheet 

See illustration below: 

 

 

 

 

To 

delete a Worksheet from a Workbook, follow the steps below: 

(i) Select the Sheet that you want to delete 

(ii) Click on Edit Menu 

(iii) Select delete sheet 

 

 



 

See illustration below: 

 

 
(5) 

Print 

previewing a document: 

To print preview a document, follow the steps below: 

(i) Click on File menu 

(ii) Click on Print preview 

(iii) Click on page break preview 

(iv) Click on Ok 

(v) Use a click-drag operation to adjust where page breaks are 

 



(vi) Right click on a free space 

(vii) Choose page set up 

(viii) Click on print preview 

(ix) Click on normal view 

See illustration below: 

 

 

 



Practical Assignments and Exercises: 

Students should be guided to perform the following in the lab 

(i) Enter and Format text and other data in the worksheet 

(ii) Use borders option in the formatting tool bar to create tables in Ms Excel 

(iii) Wrap text in a cell and also insert new columns and rows in a Worksheet 

(iv) Set up simple formulas to perform calculations 

(v) Use the Fill handle and the fill command in Edit menu to copy formulas to different cells locations 

(vi) Enter numbers as text in the worksheets 

(vii) Protect Ms Excel document from unauthorized access 

(viii) Merge and centre text in a range of cells 

(ix) Adjust column widths to accommodate data and format row heights  

(x) Copy and paste, and cut and paste operations  



 

Week 7 

 
At the end of week 7 Laboratory practical, students should be able to: 

(i) Prepare Budget with Ms Excel 

(ii) Give Column Headings (in the Budget table) different text Orientations 

(iii) Set up Formulas to perform Calculations on the Budget table 

(iv) Represent the Budget Information on Charts and Graphs 

(v) Print out the hard copy of the document 

 

(1) Preparing a typical budget table with Ms excel 

Students should be guided on how to prepare different types of budgets, which could be: 

(i) Individual daily, weekly, monthly or yearly budget 

(ii) Company’s budget 

(iii) Government’s budget (Local Govt., State, or Federal) 

The following serves as an illustration. 

Students should be guided to create a similar budget table  or any other budget table and enter 

data into the table, then set up correct formulas that would do the calculations. 

 

 

 

 



 

 

BUDGET TABLE 

 A B C D E F G 
 H 

1 
REVENUE AND EXPENSES STATEMENT FOR X Y Z (Nig.) Ltd 

2 

3  JAN FEB MARCH APRIL MAY JUNE TOTAL 

4 REVENUE 
 

      
 

5 
Computer 

Accessories 
       

6 GSM sales        

7 
Electrical 

Appliances 
       

8 
Total Sales 

       

9 
Less Returns 

       

10 Net Sales        

11 EXPENSES        

12 
Rent 

       

13 
Advertising 

       

14 
Salaries 

       

15 
Cost of Sales 

       

16 Total Expenses        

17 NET INCOME        

                            

Note: 



Returns is computed as 2% of total sales and the Cost of Sales as 5% of Total Sales. 

Net Sales is computed as Total Sales less Returns 

Total Expenses is computed as the Sum of all the Expenses 

Net Income is computed as Net Sales Less Total Expenses. 

Total is computed as the sum of each item for the Six months 

(i) Load Ms Excel and Enter the Data and formulas as may be specified by your teacher   

(ii) Save your Budget Table with a Filename 
 

(2) Giving column headings different text orientations 

To give Column headings different text orientation, follow the steps below: 

(i) Select the Column headings you want to give different orientations 

(ii) Click on Format Menu and Select Cells 

(iii) Click the Alignment tab 

(iv) Click the text Orientation and drag it to a degree of your choice 



(v) Click OK to get it done 

See illustration below 

 

(3) Setting up formulas to compute value on the budget table above: 

(i) Locate Cell B8 and enter the Formula =SUM (B5: B7) to Compute Total Sales 

(ii) Locate Cell B9 and enter the Formula = 2%*B8 to Computer Less Returns 

(iii) Locate Cell B10 and enter the Formula = B8-B9 to Compute Net Sales 

(iv) Locate Cell B15 and Enter the Formula =5%*B8 to Compute Cost of sales 

(v) Locate Cell B16 and Enter the Formula = SUM (B12:B15) to Compute Total  

  Expenses 

(vi) Locate Cell B17 and Enter the Formula = B10 – B16 to Compute the Net  

 



  

Income 

(vii) Locate CellH5 and Enter the Formula = Total for the Computer Accessories for the Six 

months 

Note: Press enter key after entering each formula 

(4) Representing the budget information on charts and graphs 

To Represent the Ms Excel budget Information on Charts and Graphs, follow the Steps below: 

(i) Select the Parts of Ms Excel Table you want to use in plotting the Chart 

(ii) Click on Insert Menu and Choose Chart 

(iii) Select Chart Type and Chart Sub Type 

(iv) Click on Next and Select the Data Range 

(v) Click on Next and Add Title to Chart in Chart Title Box 

(vi) Enter Titles for Y-axis in Value Y-axis, and X-axis in Category X-axis box 

(vii) Click on Next and Choose Finish to get it done 

See illustration below  

 



(5) Printing ms excel documents 

To print Ms Excel document, follow the steps below: 

(i) Get the document you want to Print on the display 

(ii) From the File Menu Click on Print 

(iii) Select the Printer option 

(iv) Select the print range 

(v) Select the number of Copies you want to print 

(vi) Click on Print to get it done 

 

See illustration below: 

 

 

 

 



 

Practical Assignments and Exercises: 

Students should be guided to perform the following practical in the lab: 

(i) Prepare invoice with Spreadsheet and perform calculations using formulas and  

     functions 

(ii) Use Electronic spreadsheet to prepare Class results and carry out calculations using  

      formulas and functions 

(iii) Set up a Database record in Ms Excel then Filter the records and as well sort the  

       records. 

(iv) Insert comments in a cell and rename a Worksheet 

(v) Protect a Worksheet so that the document is read only 



 

Week 8 

At the end of the Laboratory practical, students should be able to: 

 (i) Set up a Typical Payroll table in Ms Excel 

(ii) Set up Formulas to compute values in the Payroll table 

(iii) Protect Ms Excel Payroll table from unauthorized access 

(iv) Represent the Information on the Payroll table in Charts and graphs 

(v) Know how to use Worksheet Functions in performing computations 

(1) Setting up a payroll table in Ms excel 

To set up the Payroll table below in Ms Excel, Follow the Steps below: 

(i) Load Ms Excel and Enter the needed Data  

(ii) Save your payroll Table with a name 

(iii) Protect the Payroll Table with a Password  

A TYPICAL MS EXCEL PAYROLL TABLE 

 A B C D E F G H I J K L 

1      ALLOWANCES 
 

  

2 S/NO F/NO NAMES SEX B/SAL HOUSING 
TRAN MED. 

TOTAL 
TAX 

GSAL N/SAL 

3             

4             

 

 



 

(2) Setting up formulas for payroll calculations 

To perform calculations in the payroll table above, follow the steps below: 

(i) Locate Cell F3 and Enter the Formula =80% * E3 

(ii) Locate Cell G3 and Enter the Formula = 70% * E3 

(iii) Locate cell H3 and Enter the Formula = 75% * E3 

(iv) Locate Cell I3 and Enter the Formulas = SUM (F3:H3) 

(V) Locate Cell J3 and Enter the Formula = 10% * E3 

(vi) Locate Cell K3 and Enter the Formula = SUM (E3:H3) 

(Vii) Locate Cell L3 and Enter the Formula =K3 – J3 

(viii) Copy the Results 0n the Range F3: L3 to F102: L102 

(3) Protecting ms excel document from unauthorized access 

To Protect Ms Excel Document from unauthorized access, follow the steps below: 

(i) Click on File Menu and Choose Save As 

(ii) Click on Tools and Select General option 

(iii) Enter Password in the Password to Open dialog box 

(iv) Enter Password in Password to Modify box and Click OK 

(v) Enter Password in Reenter Password to Open Box and Click OK 

(vi) Enter your Password in Reenter Password to Modify box and Click OK 

(vii) Click on Save to get it done. 

(4) Representing payroll information on charts and graphs 

To Represent Ms Excel Information on Chart and Graphs, follow the Steps below: 

(i) Select the Parts of Ms Excel Table you want to use in plotting the Chart 



(ii) Click on Insert Menu and Choose Chart 

(iii) Select Chart Type and Chart Sub Type 

(iv)  Click on Next and Select and Select the Data Range 

(v) Click on Next and Add Title to Chart in Chart Title Box 

(vi) Enter Titles for Y-axis in Value Y-axis, and X-axis in Category X-axis box 

(vii) Click on Next and Choose Finish to get it done 

See illustration below 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



(5) Using Ms Excel worksheet functions for calculations 

The teacher should give the students Practical Assignments that involves the use of the 

Following worksheet functions 

(i) Mathematical Worksheet Functions 

(ii) Statistical Worksheet Functions 

(ii) Engineering Worksheet Functions 

(iv) Financial Worksheet Functions 

(v) Look-up and Reference Worksheet Functions 

(vi) Database and List Management Worksheet Functions 

(vii) Text Worksheet functions 

(viii) Logical Worksheet functions 

(ix) Information Worksheet functions 

(x) Date and Time worksheet functions 

 



 

Week 9 
 

At the end of week 9 Laboratory practical, students should be able to use Peachtree or DacEasy 

Accounting to: 

(i) Prepare general Ledger 

(ii) Prepare Account Receivables 

(iii) Prepare Account Payables 

(iv) Prepare Payroll 

(v) Prepare Invoice 

(1) Preparing general ledger with DacEasy Accounting software Package: 

To prepare general Ledger with DacEasy Accounting, follow the steps below: 

(i) Load DacEasy Accounting for Windows 

(ii) Click on Transactions menu 

(iii) Select general Ledger 

(iv) Enter your Account (i.e. the transactions) in General Ledger Transaction Entry 

(v) Save  

(2) Preparing Account Receivables with DacEasy Accounting software Package: 

To prepare Account Receivables with DacEasy Accounting, follow the steps below: 



(i) Load DacEasy Accounting for Windows 

(ii) Click on Transactions menu 

(iii) Select receivables ledger 

(iv) Enter your Accounts in Receivables ledger Transaction entry 

(v) Save your entries 

(3) Preparing Account payables with DacEasy Accounting software Package: 

To prepare Account Receivables with DacEasy Accounting, follow the steps below 

(i) Load DacEasy Accounting for Windows 

(ii) Click on Transactions menu 

(iii) Select Payables ledger 

(iv) Enter your Accounts in Payables ledger Transaction entry 

(v) Save your entries 

(4) Preparing payroll with DacEasy Accounting software Package 

To prepare payroll with DacEasy Accounting, follow the steps below 

(i) Load DacEasy Accounting for Windows 

(ii) Click on modules and select Payroll 

(iii) Enter the payroll data 

(iv) Follow the instructions until you are through  

(5) Preparing invoice with DacEasy Accounting software Package 



To prepare invoice with DacEasy Accounting, follow the steps below: 

(i) Load DacEasy Accounting for Windows 

(ii) Click on invoices Icon  

(iii) Make your entries in the invoice  

(iv) Save your Entries 

 



 

Week 10  
 

At the end of week 9 Laboratory practical, students should be able to use Peachtree or DacEasy 

Accounting to: 

(i) Prepare general Ledger 

(ii) Prepare Account Receivables 

(iii) Prepare Account Payables 

(iv) Prepare Payroll 

(v) Prepare Invoice 

(1) Preparing general ledger with DacEasy Accounting software Package: 

To prepare general Ledger with DacEasy Accounting, follow the steps below: 

(i) Load DacEasy Accounting for Windows 

(ii) Click on Transactions menu 

(iii) Select general Ledger 

(iv) Enter your Account (i.e. the transactions) in General Ledger Transaction Entry 

(v) Save  

(2) Preparing Account Receivables with DacEasy Accounting software Package: 

To prepare Account Receivables with DacEasy Accounting, follow the steps below: 



(i) Load DacEasy Accounting for Windows 

(ii) Click on Transactions menu 

(iii) Select receivables ledger 

(iv) Enter your Accounts in Receivables ledger Transaction entry 

(v) Save your entries 

 

(3) Preparing Account payables with DacEasy Accounting software Package: 

To prepare Account Receivables with DacEasy Accounting, follow the steps below 

(i) Load DacEasy Accounting for Windows 

(ii) Click on Transactions menu 

(iii) Select Payables ledger 

(iv) Enter your Accounts in Payables ledger Transaction entry 

(v) Save your entries 

(4) Preparing payroll with DacEasy Accounting software Package 

To prepare payroll with DacEasy Accounting, follow the steps below 

(i) Load DacEasy Accounting for Windows 

(ii) Click on modules and select Payroll 

(iii) Enter the payroll data 

(iv) Save your entries 



 

  

(5) Preparing invoice with DacEasy Accounting software Package 

To prepare invoice with DacEasy Accounting, follow the steps below: 

(i) Load DacEasy Accounting for Windows 

(ii) Click on invoices Icon  

(iii) Make your entries in the invoice  

(iv) Save your Entries 

 

 

 



 

Week 11 

At the end of week 11 Practical, students should be able to: 

(1) Create and save a New Presentation with Ms Power Point 

(2) Create a New Slide and then change the layout of a Slide 

(3) Insert Music or Sound in a Slide 

(4) Insert Video in a Slide 

(5) Change a Slide background color 

(1) Creating and saving a Presentation based on suggested Contents and Design: 

 To Create and Save a presentation based on suggested contents and Design, follow        the steps below: 

(i)  Click on File menu and choose New 

(ii) Click on General tab and Double-Click on AutoContent wizard 

(iii) Follow the instructions in the Wizard 

(iv) Change the Sample Presentation to suit your need 

(v) When you finish, click Save on the File Menu 

(vi) Name your Presentation and Click save 

See illustrations below 

 

 



 

 

 

 

 

 

 

(2) Creating a New Slide and then changing the layout of a Slide 

To create a New Slide, follow the steps below: 

(i) Click on insert menu and choose New slide 

(2) Scroll through the layout and then click the one you want 

See illustration below: 

 

 

 

 

(3) Inserting Music or sound in a flash: 

To insert music or Sound in a Slide, follow the steps below: 

(i) Display the Slide you want to add Music or Sound to 

(ii) Click on insert Menu and point to movies and sound 



(iii) To insert Sound from the Clip gallery, click sound from gallery 

(iv) Locate and insert the Sound that you want 

(v) To insert Sound from another location, click sound from file 

(vi) Locate the Folder that contains the Sound 

(vii) Double Click the Sound that you want 

(viii) Click yes if you want the sound to play automatically when you go to the slide 

(ix) Click No if you want the sound to play only when you click the Slide icon during a  

Slideshow 

 

(4) Inserting Video in a Slide: 

To insert video in a Slide, follow the steps below: 

(i) Display the Slide you want to add the video to 

(ii) Click on Insert Menu  

(iii) Point to movies and sound 

(iv) To insert a video from the clip gallery, click movie from the gallery 

(v) Locate and insert the video that you want 

(vi) To insert a video from another location, click movie from file 

(vii) Locate the folder that contains the video 



(viii) Double click the video that you want  

(ix) Click yes if you want the video to play automatically when you go to the slide 

(x) Click No if you want the video to play only when you click the movie during a  

Slideshow 

(5) Changing a Slide background color: 

To change a Slide background color, follow the steps below: 

(i) Display the Slide that you want to change background 

(ii) Click on Format menu and choose background 

(iii) Click the down arrow under Background fill 

(iv) Click on one of the eight colors below automatic to change to a color in the color scheme 

(v) To change to a color that is not in the color scheme click more colors 

(vi) To apply the change to the current Slide, click Apply. 

 

See illustration below: 

 

 

 



 

 

Week 12  

 

At the end of week 11 Practical, students should be able to: 

(1) Create and save a New Presentation with Ms Power Point 

(2) Create a New Slide and then change the layout of a Slide 

(3) Insert Music or Sound in a Slide 

(4) Insert Video in a Slide 

(5) Change a Slide background color 

 

(1) Creating and saving a Presentation based on suggested Contents and Design: 

 To Create and Save a presentation based on suggested contents and Design, follow        the steps below: 

(i)  Click on File menu and choose New 

(ii) Click on General tab and Double-Click on AutoContent wizard 

(iii) Follow the instructions in the Wizard 

(iv) Change the Sample Presentation to suit your need 

(v) When you finish, click Save on the File Menu 

(vi) Name your Presentation and Click save 



See illustrations below 

 

 

 

 

 

 

 

 

 

(2) Creating a New Slide and then changing the layout of a Slide 

To create a New Slide, follow the steps below: 

(i) Click on insert menu and choose New slide 

(2) Scroll through the layout and then click the one you want 

See illustration below: 

 

 

 

 

(3) Inserting Music or sound in a flash: 

To insert music or Sound in a Slide, follow the steps below: 



(i) Display the Slide you want to add Music or Sound to 

(ii) Click on insert Menu and point to movies and sound 

(iii) To insert Sound from the Clip gallery, click sound from gallery 

(iv) Locate and insert the Sound that you want 

(v) To insert Sound from another location, click sound from file 

(vi) Locate the Folder that contains the Sound 

(vii) Double Click the Sound that you want 

(viii) Click yes if you want the sound to play automatically when you go to the slide 

(ix) Click No if you want the sound to play only when you click the Slide icon during a  

Slideshow 

(4) Inserting Video in a Slide: 

To insert video in a Slide, follow the steps below: 

(i) Display the Slide you want to add the video to 

(ii) Click on Insert Menu  

(iii) Point to movies and sound 

(iv) To insert a video from the clip gallery, click movie from the gallery 

(v) Locate and insert the video that you want 

(vi) To insert a video from another location, click movie from file 



(vii) Locate the folder that contains the video 

(viii) Double click the video that you want  

(ix) Click yes if you want the video to play automatically when you go to the slide 

(x) Click No if you want the video to play only when you click the movie during a  

Slideshow 

(5) Changing a Slide background color: 

To change a Slide background color, follow the steps below: 

(i) Display the Slide that you want to change background 

(ii) Click on Format menu and choose background 

(iii) Click the down arrow under Background fill 

(iv) Click on one of the eight colors below automatic to change to a color in the color scheme 

(v) To change to a color that is not in the color scheme click more colors 

(vi) To apply the change to the current Slide, click Apply. 

See illustration below: 

 

 

 



 

 

Week 13 

At the end of week 11 Practical, students should be able to: 

(1) Carry out Presentation on Sales promotion 

(2) Carry out presentation on marketing plan 

(3) Carry out Presentation on Company’s meeting 

(4) Carry out Presentation on Employee’s orientation 

(5) Carry out Presentation on Selling a Product 

 

(1) Carrying out presentation on Sales Promotion  

To carry out Presentation on Sales promotion, follow the steps below: 

(i) Load Ms Power point  

(ii) Select create a new Presentation using Autocontent Wizard 

(iii) Click on Ok 

(iv) Click on Next 

(V) Click on All and Select Sales promotion 

(vi) Select Next 

(vii) Select On-Screen Presentation 

(viii) Enter presentation Title and Footer 

(ix) Click on Next 

(x) Click on Finish 

 

(2) Carrying out presentation on Marketing Plan  

To carry out Presentation on marketing plan, follow the steps below: 



(i) Load Ms Power point  

(ii) Select create a new Presentation using Autocontent Wizard 

(iii) Click on Ok 

(iv) Click on Next 

(V) Click on All and Select Marketing Plan 

(vi) Select Next 

(vii) Select On-Screen Presentation 

(viii) Enter presentation Title and Footer 

(ix) Click on Next 

(x) Click on Finish 

 

(3) Carrying out presentation on Company’s Meeting 

To carry out Presentation on Company’s meeting, follow the steps below: 

(i) Load Ms Power point  

(ii) Select create a new Presentation using Autocontent Wizard 

(iii) Click on Ok 

(iv) Click on Next 

(V) Click on All and Select Company’s Meeting 

(vi) Select Next 

(vii) Select On-Screen Presentation 

(viii) Enter presentation Title and Footer 

(ix) Click on Next 

(x) Click on Finish 

 

(4) Carrying out presentation on Employee’s Orientation  



To carry out Presentation on employee’s orientation, follow the steps below: 

(i) Load Ms Power point  

(ii) Select create a new Presentation using Autocontent Wizard 

(iii) Click on Ok 

(iv) Click on Next 

(V) Click on All and Select Employee’s orientation 

(vi) Select Next 

(vii) Select On-Screen Presentation 

(viii) Enter presentation Title and Footer 

(ix) Click on Next 

(x) Click on Finish 

 

(5) Carrying out presentation on Selling a Product  

To carry out Presentation on Selling a product, follow the steps below: 

(i) Load Ms Power point  

(ii) Select create a new Presentation using Autocontent Wizard 

(iii) Click on Ok 

(iv) Click on Next 

(V) Click on All and Select Selling a Product 

(vi) Select Next 

(vii) Select On-Screen Presentation 

(viii) Enter presentation Title and Footer 

(ix) Click on Next 

(x) Click on Finish 

 



 

See illustration of Presentation on training 

 



 

Week 14 

At the end of week 14 practical, students should be able to:  

 

(1) Load Medical Software Package such as “the family doctor” or “Home Medical   

      Advisor”. 

(2) Enter The Family Doctor Library, access “Ask the Doctor table of contents” and  

     obtain facts on the Immune System of the human body 

(3) Enter The Family Doctor Library, access “ Public Health Information” and obtain  

      Doctors’ Advises on danger of Smoking, danger of using Cocaine, as well as facts on   

      Prevention of HIV infection.  

 

(1) To load Medical software Package such as The Family Doctor, follow the steps  

      below: 

(i) Click on Start button 

(ii) Select All programs 

(iii) Point to Family Doctor-4
th

 Edition 

(iv) Click on the Family 

 

 



 

See illustration below: 

 

 

 

 

 

 

 

 

 

 

 

 

(2) To Enter the Library, access Ask the Doctor table of contents and obtain facts on the 

immune system of the body, follow the steps below: 

 (i) Load Family Doctor-4 

(ii) Click on Library 

(iii) Click on Ask the Doctor 

(iv) Click on Immune System. 



See illustration below: 

 

 

 

 

 

 

 

 

 

 

 

(3) To Enter the Library, access Public Health Information table of contents and obtain 

facts on smoking and Cancer, follow the steps below: 

(i) Load Family doctor - 4 

(ii) Click on Library 

(iii) Click on Public Health information 

(iv) Click on Smoking and choose smoking and Cancer 

See illustration below: 

 

 

 

 



 

(3) To Enter the Library, access Public Health Information table of contents and obtain 

facts on Cocaine, follow the steps below: 

(i) Load Family doctor - 4 

(ii) Click on Library 

(iii) Click on Public Health information 

(iv) Click on Drugs and Alcohol 

(v) Click on Basic description of drugs 

(vi) Select Cocaine 

See illustration below: 

 

 

 

 

 

 

 



(3) To Enter the Library, access Public Health Information table of contents and obtain 

facts on Prevention of HIV infection, follow the steps below: 

(i) Load Family doctor - 4 

(ii) Click on Library 

(iii) Click on Public Health information 

(iv) Click on Diseases and Disorders 

(v) click on AIDS 

(vi) Click on HIV infection and AIDS 

(vii) Click on Prevention of HIV infection 

See illustration below: 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 



 

Week 15 
 

At the end of week 15 practical, students should be able to use The Family Doctor Medical software 

Package to: 

(1) Get facts about effect of Caffeine on the body 

(2) Know the symptoms of Depression 

(3) Know the side effect of a particular Drug 

(4) know the First aid Treatment of Animal bites 

(5) Look for the meaning of a Particular Medical terminology 

(1) Getting facts about effect of Caffeine on the body: 

To get facts about the effects of Caffeine on the body, follow the steps below: 

(i) Load the family Doctor Medical Software Package 

(ii) Click on Library 

(iii) Select Alternative Encyclopedia 

(iv) Click on Drug Abuse and Addiction 

(v) Click on Caffeine 

(vi) Click on Caffeine’s Effect on the body 

 



 

See illustration: 

 

 

 

 

 

 

 

(2) Knowing the Symptoms of Depression: 

To know the Symptoms of Depression, follow the steps below: 

(i) Load The Family doctor Medical Software Package 

(ii) Click on Library 

(iii) Select Alternative Encyclopedia 

(iv) Click on Mental Health Disorders 

(v) Click on Depression 

(vi) Select symptoms of Depression 

 

 



 

See illustration: 

 

 

 

 

 

 

 

 

 

 

(3) Knowing the Side Effect of a Particular Drug: 

To know the side effect of a particular drug on the Patient, follow the steps below: 

(i) Load The Family Doctor Medical Software Package 

(ii) Click on Library 

(iii) Click on USPC Drug guide 

(iv) Enter a Drug name and Click Ok 

(v) Finally, Click on Side Effect of this Medicine 

 

 



 

See illustration: 

 

(4) 

Knowing the First Aid treatments for Animal bites 

To know the First Aid Treatment for Animal bites, follow the steps below: 

(i) Load The Family Doctor Medical Software Package 

(ii) Click on Library 

(iii) Click on National Safety Council first Aid book 

(iv) Select bites and Stings 

(v) Choose Animal bite 

(vI) Select Treatment of Animal bite 

 

 



 

See illustration below: 

 

 

 

 

 

 

 

(5) Looking for the Meaning of a Particular Medical Terminology: 

To know the Meaning of a Particular Medical Terminology, follow the steps below: 

(i) Load The Family Doctor Medical Software Package 

(ii) Click on Library 

(iii) Choose Random House Medical dictionary 

(iv) Enter a Medical terminology 

(v) Click on Look up 

See illustration 
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